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recommends its customers obtain the latest version of the relevant information to 
establish that the information being relied upon is current and before ordering any 
products.
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Type Conventions Used in This Document

Convention Meaning or Use

Bold Items in the user interface that you select or click. Text that you type 
into the user interface.

<Italic> Variables in commands, code syntax, and path names.

Ctrl+L Press the two keys at the same time.

Courier Code examples. Messages, reports, and prompts from the software.

... Omitted material in a line of code.

.

.

.

Omitted lines in code and report examples.

[ ] Optional items in syntax descriptions. In bus specifications, the 
brackets are required.

( ) Grouped items in syntax descriptions.

{ } Repeatable items in syntax descriptions.

| A choice between items in syntax descriptions.
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Chapter 1

Installing Gold2 Tools

This document provides installation instructions for the Lattice Gold2TM Linux 
software.

Gold2 supports ECP5U, CrossLink™ (LIFMD), MachXO2TM, MachXO3LTM, 
and MachXO3LFTM designs. 

System Requirements
The following are the basic system requirements for Lattice Gold2 on 
Linux:

 Intel Pentium or Pentium-compatible PC, or AMD Opteron system
support:

For Programmer:

 The Lattice Gold2 64-bit release contains a 64-bit driver to support
the 64-bit system.

 Red Hat Enterprise Linux version 6.9 or 7.4 operating system.

The host operating system can only be 64-bit.

 The Lattice Gold2 software has 64-bit specific application programs
to run on Red Hat 64 platforms.

 The Lattice Gold2 software is available in 64-bit versions. The 64-
bit version of Lattice Gold2 can only be installed on 64-bit systems.

Note:
The available devices vary depending on the type of license.

IMPORTANT:
This release of Lattice Gold2 does NOT support Active-HDL Lattice edition, Synplify Pro for 
Lattice, and LatticeMico Development Tools.
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 Approximately 5.75 GB free disk space

 Network adapter and network connectivity

 1024 x 768 graphics display

 JavaScript-capable Web browser

 Adobe Acrobat Reader, or equivalent PDF reader

Memory Requirements
Table 1 lists the minimum memory requirements and recommended memory 
for all the Lattice Semiconductor FPGA families.

Note

A floating license requires access to the license server, so both a network adapter 
and connectivity are required.

Table 1:  Recommended Memory for Linux

Device Size 64-Bit Operating Systems

Minimum Recommended

ECP5G, ECP5U, ECP5UM All 4 GB 6 GB

LatticeEC, LatticeECP Up to 20K LUT 1 GB 1.5 GB

Up to 50K LUT 1.5 GB 2 GB

LatticeECP2/M Up to 20K LUT 1.5 GB 2 GB

Up to 50K LUT 2 GB 3 GB

Up to 100K LUT 2 GB 4 GB

LatticeECP3 Up to 95K LUT 4 GB 6 GB

Up to 150K LUT 6 GB 8 GB

LatticeSC/M Up to 40K LUT 1.5 GB 2 GB

Up to 115K LUT 2 GB 5 GB

LatticeXP, LatticeXP2 Up to 20K LUT 1 GB 1.5 GB

Up to 50K LUT 1.5 GB 2 GB

LIFMD (CrossLink) All 512 MB 1 GB

MachXO, MachXO2, 
MachXO3D, MachXO3L, 
MachXO3LF

All 512 MB 1 GB

Platform Manager,
Platform Manager 2

All 512 MB 1 GB
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Contacting Technical Support
FAQs The first place to look. The Answer Database provides solutions to 
questions that many of our customers have already asked. Lattice 
Applications Engineers are continuously adding to the Database. 

To access the Answer Database, go to www.latticesemi.com > Support > 
Answer Database.

Telephone Support Hotline Receive direct technical support for all Lattice 
products by calling Lattice Applications from 5:30 a.m. to 6 p.m. Pacific Time.

 For USA & Canada: 1-800-LATTICE (528-8423)

 For other locations: +1 503 268 8001

In Asia, call Lattice Applications from 8:30 a.m. to 5:30 p.m. Beijing Time 
(CST), +0800 UTC. Chinese and English language only.

 For Asia: +86 21 52989090

E-mail Support

 techsupport@latticesemi.com

For Local Support Contact your nearest Lattice Sales Office.

Installer Contents
The Lattice Gold2 RPM installation packages are available for download 
from http://www.latticesemi.com/latticediamond. Click the Downloads tab. 
Some documents and downloads are not visible to anonymous visitors. To 
view all items, please log in to your Lattice account. Follow the product 
download instructions and uncompress the software.

The following describes the contents of the Lattice Gold2 installer.

 The Lattice Gold2, Reveal, Programmer, and Power Estimator Linux
installer rpm files have the following convention for 64-bit platforms.

 [product]_[version]-x86_64-linux.rpm - 64-bit platform

 The Lattice Gold2, Reveal, Programmer, and Power Estimator rpm file
names are as follows:

 gold2_1_0-base_x64-1-0-x86_64-linux.rpm

 gold2-powerestimator_1_0_x64-1-0-x86_64-linux.rpm

 gold2-programmer_1_0_x64-1-0-x86_64-linux.rpm

 gold2-reveal_1_0_x64-1-0-x86_64-linux.rpm

 The Lattice Gold2 “base” installation file (.rpm) installs Lattice Gold2. See
“Gold2 Release System Library Dependencies” on page 12 for more
information.

 The Reveal installation file (.rpm) installs the stand-alone Reveal
Analyzer. It is not necessary to install this package if the Gold2 Base

mailto:techsupport@latticesemi.com
http://www.latticesemi.com/en/Support/AnswerDatabase.aspx
http://www.latticesemi.com/Buy.aspx
http://www.latticesemi.com
http://www.latticesemi.com/latticediamond
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RPM is installed. See “Installing Stand-Alone Reveal Analyzer” on 
page 15 for more information.

 The Programmer installation file (.rpm) installs the stand-alone Gold2
Programmer. It is not necessary to install this package if the Gold2 Base
RPM is installed. See “Installing Stand-Alone Programmer” on page 16
for more information.

 The Power Estimator (.rpm) file installs the stand-alone Gold2 Power
Estimator. It is not necessary to install this package if the Gold2 Base
RPM is installed. See “Installing Stand-Alone Power Estimator” on page
16 for more information.

 The LatticeMico installation file (.rpm) installs LatticeMico Development
Tools and GNU-based Compiler Tools. See “Installing LatticeMico
Development Tools” on page 36 for more information.

 The Installation Notice contains installation and licensing information.

Gold2 Installed Directory Structure
Table 2 shows the Lattice Gold2 software directory structure after 

installation:

Table 2: The Gold2 Software Directory Structure

File or Directory Description

bin/lin64/ This directory contains files for running the Lattice Gold2 64-bit 
GUI.

cae_library/ This directory contains synthesis header libraries for Synplify 
Pro in both Verilog and VHDL formats. It also contains the 
libraries for interface kits (ispLSI® design and simulation 
libraries).

data/ This directory contains files for the Lattice Gold2 software.

docs/ This directory contains Lattice Gold2 documentation, 
including manuals, tutorials, and the online Help.

embedded_source/ This directory contains source code files for the JTAG Full VME, 
JTAG Slim VME, Slave SPI, I2C, and sysCONFIG embedded 
systems for Lattice FPGA devices.

examples/ This directory contains Lattice design examples.

ispfpga/ This directory contains files for the Lattice Gold2 software.

license/ This directory contains the license agreement.

module/ This directory contains Lattice module files.

tcltk/ This directory contains tcl/tk related files.
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Installing Lattice Gold2 on 64-Bit Platforms
Before installing the Lattice Gold2 software, download the installation files 
from the Lattice Semiconductor Web site. For more information on how to 
download the Gold2 software, go to
http://www.latticesemi.com/latticediamond. Click the Downloads tab. Some 
documents and downloads are not visible to anonymous visitors. To view all 
items, please log in to your Lattice account. Follow the product download 
instructions and uncompress the software.

RPM installation files are provided to simplify the installation process. The 
RPM file has a companion MD5 checksum file. The MD5 file permits you to 
validate the integrity of the RPM file. 

Lattice Gold2 for 64-bit systems is installed with the 
gold2_1_0-base_x64-1-0-x86_64-linux.rpm installation file. The file installs 
all Lattice Semiconductor FPGA devices on your 64-bit system. It also installs 
the Synplify Pro for Lattice software. The following section guides you 
through the installation procedure step by step.

To install the Gold2  software on 64-bit systems:

1. Verify the integrity of the first RPM file. Make sure the companion MD5 file
is located in the same directory as the RPM file.

% cd <directory_with_RPM>
% rpm -K gold2_1_0-base_x64-1-0-x86_64-linux.rpm

2. Install the Gold2  software. The default installation directory for Gold2
is /usr/local/gold2. You have the option of changing the installation
directory.

 To install to the default location (/usr/local/gold2):

% sudo rpm -Uvh <path_to_package>/gold2_1_0-base_x64-1-0-

x86_64-linux.rpm

 To override the default location:

Note

Platform Manager 2 devices require the Gold2 Platform Designer tool. The LatticeMico 
Development Tools must be installed along with Gold2 in order to use Platform 
Designer, Refer to “Installing LatticeMico Development Tools” on page 36.

Note

 You need root privilege to install an RPM package.

 In the Gold2 installation, blank space characters are not allowed in
the installation directory path name.

(NOT supported in Lattice Gold2)

http://www.latticesemi.com/latticediamond
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% sudo rpm -Uvh --prefix <install_path> 
<path_to_package>/gold2_1_0-base_x64-1-0-x86_64-
linux.rpm

Gold2 1.0 Release System Library Dependencies
The Gold2 RPM package depends on a set of packages that provide 64-bit 
system libraries. Some of these packages may depend on lower level 
packages, the indirect dependencies. To fulfill this dependency, these 
packages must be installed before Gold2 1.0 can be installed. Check which 
ones are already present on your system by entering the command rpm -
qa | grep <package name> and confirming that the named package 
appears in the results.

The following packages are the packages gold2_1_0-base_x64-1-0-
x86_64-linux.rpm depends on. This list does not include packages that are 
included with Gold2 1.0. Indirect dependencies are listed with indented 
levels.

 glibc

 nss-softokn-freebl

 libjpeg

 libtiff

 zlib

 glib2

 libselinux

 gamin

 libusb

 freetype

Note

The --prefix can not be used to install directly to Network Attached Storage. 
The --prefix must point to a location writable by the sudo command.

If networked installation is desired, install Gold2 locally, and then transfer the 
file structure to your Network Attached Storage system.

Note

The RPM installation process for Gold2 verifies the Linux operating system has 
all of the required support libraries installed. If library files required for running 
Gold2 are not installed on the system Gold2 will not be installed.

If you want to force the installation to continue, you can use “--nodeps” on 
the rpm command to ignore the dependency information. Gold2 may not 
function correctly if the “--nodeps” switch is used to force installation of Gold2 
to proceed.
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 fontconfig

 expat

 libX11

 libxcb

 libXau

 libICE

 libSM

 libuuid

 libXt

 libXext

 libXrender

 libXi

 libXft

Installing the packages one by one requires the parent package to be installed 
last. The package deepest in the tree must be installed first. For example, 
libICE package depends on libSM. The libSM package must be installed prior 
to libICE.

Two cyclic dependencies are found with Gold2, glibc and nss-softokn-
freebl, and glib2 and gamin. Installing these packages requires the two 
RPM's to be specified on the same rpm command line.

Using an Automatic Package Installer 
for RPM Systems
If you have an officially licensed Red Hat release and register at Red Hat 
support site with an RHN (Red Hat Network) serial number, you can use the 
YUM installation mechanism.

YUM is an automatic updater and package installer/remover for rpm systems. 
It automatically computes dependencies and determines the order of 
installation for the dependent packages. It makes it easier to install necessary 
support libraries.

If you register with an RHN, Red Hat automatically sets up the YUM repository 
information on your machine. You only need to run the following command, 
assuming root privileges, to install gold2_1_0-base without going through the 
manual rpm installation process described in section 3.

# yum install gold2_1_0-base_x64-1-0-x86_64-linux.rpm

Note

User needs to make sure libusb-0.1.so.4 and libXss.so.1 are installed in Red Hat 7.4, 
and they are default installed in Red Hat 6.9 or earlier.
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If you do not register your operating system installation with Red Hat RHN, 
you still can setup a locally mounted DVD as a YUM repository. You must 
perform the following steps.

1. Create a yum repository file at /etc/yum.repos.d/iso.repo. Note that the
baseurl must reflect your actual DVD mounted path.

% My-ISO-Repository]
% baseurl="file:///media/RHEL_6.0 x86_64 Disc 1"
% enabled=1
% gpgcheck=0
% gpgkey="file:///media/RHEL_6.0 x86_64 Disc 1"

2. Copy the "media.repo" in DVD into /etc/yum.repos.d/
package_media.repo. Note that "media.repo" on the DVD may differ
depending on release version. For example, for CentOS it is CentOS-
Base.repo.

3. Import the GPG key files associated with the release package files.

% cd /media/RHEL_6.2\ x86_64\ Disc
% rpm --import *GPG*

4. Change the value of etc/yum.conf as follows:

% Change gpgcheck=1 to gpgcheck=0

5. Restart computer.

You can consult the following two web sites for further information about YUM.

http://yum.baseurl.org/

http://docs.redhat.com/docs/en-US/Red_Hat_Enterprise_Linux/6/html/
Deployment_Guide/ch-yum.html

Installing Gold2 Tools from RPM Without 
Root Access

The Gold2  tools can be installed from RPM without requiring root access. 
One application of this is installing directly to a remote filesystem, allowing 
one installation to serve multiple Linux client machines. In order to install 
directly to the network the RPM installation must be performed without 
elevated permissions. Use the following procedures to install all of the 
Gold2  tools to a remote filesystem.

The commands shown should be run from a system that is similar/identical 
to the one to be used by the Gold2  users. 

Red Hat 6 and 7 Users
% cd ~
% mkdir -p myrpmdb/var/lock/rpm

Create a temporary RPM database

http://yum.baseurl.org/
http://docs.redhat.com/docs/en-US/Red_Hat_Enterprise_Linux/6/html/Deployment_Guide/ch-yum.html
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% /usr/bin/rpmdb --initdb --root $HOME/myrpmdb --dbpath $HOME/
myrpmdb

Check to see if the Linux installation is missing any support libraries.

% /bin/rpm --test -Uvh <diamond_package>.rpm

Install the software

% /bin/rpm --dbpath $HOME/myrpmdb --nodeps --prefix 
<path_to_remote_filesystem> -Uvh <diamond_package>.rpm

Once all packages are installed the temporary RPM database can be 
removed.

Installing Stand-Alone Reveal Analyzer
Reveal Analyzer is included in the Gold2  installation. If you want to use the 
tool without installing Lattice Gold2, use one of the following files to install 
the stand-alone Reveal Analyzer:

 gold2-reveal_1_0_x64-1-0-x86_64-linux.rpm for 64-bit systems.

To install the stand-alone Reveal Analyzer:

1. Verify the integrity of the RPM file. Make sure the companion MD5 file is
located in the same directory as the RPM file.

% cd <directory_with_RPM>
% rpm -K reveal_3_11_x64-396-4-x86_64-linux.rpm

2. Install the Reveal Analyzer software. The default installation directory for
Reveal Analyzer is /usr/local/reveal. You have the option of changing the
installation directory.

 To install to the default location (/usr/local/reveal):

% sudo rpm -Uvh <path_to_package>/reveal_3_11_x64-396-4-
x86_64-linux.rpm

 To override the default location:

% sudo rpm -Uvh --prefix <install_path>
<path_to_package>/reveal_3_11_x64-396-4-x86_64-linux.rpm

Note

This process can also be used for local filesystem installations by a non-privileged 
user.

Note

The --prefix can not be used to install directly to Network Attached Storage. 
The --prefix must point to a location writable by the sudo command.

If networked installation is desired, install Gold2 locally, and then transfer the 
file structure to your Network Attached Storage system.
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Installing Stand-Alone Programmer
Programmer is included in the Gold2  installation and consists of five tools:

 Programmer

 Deployment Tool

 Download Debugger

 Programming File Utility

 Model 300 Programmer

If you want to use Programmer, Deployment Tool, Download Debugger, 
Programming File Utility, or Model 300 Programmer without installing Lattice 
Gold2 , use one of the following files to install the stand-alone Programmer:

 gold2-programmer_1_0_x64-1-0-x86_64-linux.rpm for 64-bit systems.

To install the stand-alone Programmer:

1. Verify the integrity of the RPM file.

% cd <directory_with_RPM>

% rpm -K gold2-programmer_1_0_x64-1-0-x86_64-linux.rpm

2. Install the Programmer software. The default installation directory for
Programmer is /usr/local/programmer. You have the option of changing
the installation directory.

 To install to the default location (/usr/local/programmer):

% sudo rpm -Uvh <path_to_package>/gold2-

programmer_1_0_x64-1-0-x86_64-linux.rpm

 To override the default location:

% sudo rpm -Uvh --prefix <install_path>
<path_to_package>/gold2-programmer_1_0_x64-1-0-
x86_64-linux.rpmrpm

Installing Stand-Alone Power Estimator
Power Estimator is included in the Gold2 installation. If you want to use the 
tool without installing Lattice Gold2 , use one of the following files to install 
the stand-alone Power Estimator:

 gold2-powerestimator_1_0_x64-1-0-x86_64-linux.rpm.

Note

The --prefix can not be used to install directly to Network Attached Storage.  The -
-prefix must point to a location writable by the sudo command.

If networked installation is desired, install Gold2  locally, and then transfer the file 
structure to your Network Attached Storage system.
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Stand-alone Power Estimator requires a license. Refer to “Licensing Lattice 
Gold2  and Stand-Alone Power Estimator” on page 25.

To install the stand-alone Power Estimator:

1. Verify the integrity of the RPM file.

% cd <directory_with_RPM>

% rpm -K gold2-powerestimator_1_0_x64-1-0-x86_64-linux.rpm

2. Install the Power Estimator software. The default installation directory for
Power Estimator is /usr/local/powerestimator You have the option of
changing the installation directory.

 To install to the default location (/usr/local/powerestimator):% sudo

rpm -Uvh <path_to_package>/gold2-

powerestimator_1_0_x64-1-0-x86_64-linux.rpm

 To override the default location:

% sudo rpm -Uvh --prefix <install_path>
<path_to_package>/gold2-powerestimator_1_0_x64-1-0-
x86_64-linux.rpm

Installing and Configuring USB Cable 
and Parallel Cable
This section provides information on USB cable and parallel cable installation 
and configuration. These instructions are applicable for 64-bit Linux systems.

Parallel Programming Cable Configuration

Before using the Lattice parallel programming cable, the computer’s parallel 
port must be enabled and have the correct read/write permission. Contact the 
system administrator if the parallel port is not enabled or does not have the 
correct read/write permission. 

You can check the current permissions of the parallel port by navigating to the 
/dev directory and doing a lookup on the port, as follows

% cd /dev ls –l parport0 

There are two main ways to give read/write permission to the parallel port. 
The first is to give read/write permission to the parallel port to anyone that has 
access to that machine. The second is more secure, where only selected 
individuals will have read/write permission to the parallel port that has access 

Note

The --prefix can not be used to install directly to Network Attached Storage. 
The --prefix must point to a location writable by the sudo command.

If networked installation is desired, install Gold2  locally, and then transfer the 
file structure to your Network Attached Storage system.
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to that machine. Below are the descriptions on how to setup parallel port zero 
to have read/write permission. 

Giving Parallel Port Zero Read/Write Permission to All Users

1. Log in as root.

2. Change directory to the /dev directory as follows:

% cd /dev <return>

3. Give read/write permission to parallel port zero (parport0) as follows:

% chmod 666 parport0 <return>

Giving Parallel Port Zero Read/Write Permission to Selected Individuals

There are two files to change on the machine to give selected individuals 
read/write permission to parallel port zero. Both files are located in the /etc 
directory. The two files are “group” and “nsswitch.conf”.

1. Log in as root.

2. Change directory to the /dev directory as follows:

% cd /dev <return>

3. Give read/write permission to parallel port zero (parport0) to owner and
group as follows:

% chmod 666 parport0 <return>

4. Change directory to the /etc directory as follows:

% cd /etc <return>

5. Using your favorite text editor, edit the file “group” as follows:

Add the login name for all the users you want to give read/write
permission for parallel port zero by adding the login names to the
“lp:x:7:” line. This line may vary from system to system. Two examples
are shown below.

Example 1: Change:

lp:x:7:

to:

lp:x:7:user_name1,user_name2,etc

Example 2: Change:

lp:x:7:daemon,lp

to:

lp:x:7:daemon,lp,user_name1,user_name2,etc

where user_name1, etc., are the login names for all the users you
want to give read/write permission for parallel port zero. Save the changes
and close the “group” file.

6. Using your favorite text editor, edit the file “nsswitch.conf” as follows:

Look at the group line. Ensure “files” is there.
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For example: 

group: files nis

7. Reboot for the changes to take effect.

Lattice USB2A USB Download Cable Configuration 
Programmer software can directly access USB devices using libusb, which 
accesses the USB file system. To verify that you have the USB library 
installed, do the following:

1. Plug in the USB cable.

2. On the command line, type:

% /sbin/lsusb

You should see an entry similar to the following:

> Bus 002 Device 002: ID 1134:8001

3. If you receive an error when you type /sbin/lsusb, you probably do
not have libusb installed. To install the libusb, go to:

http://libusb.sourceforge.net/

4. Unplug the cable.

Driver Setup for Lattice USB2A and HW-
USBN-2B (FTDI) USB Download Cable on Red 
Hat Linux Enterprise 7.4 

Manual UDEV Method Configuration:

1. Find your username which is given in /etc/group file. Log out if required.
For example :

username:x:1000:username

2. Create a working file called 10-local.rules.

Note

The USB cable must be disconnected from the PC when performing the installations. 
You must have root access and be able to log in as a super user.

Note

User needs to download and install libusb-0.1.4-3.el7.x86_64.rpm first in Red Hat 7.4.

http://libusb.sourceforge.net/ 
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3. Add the following information to the 10-local.rules file:

4. Copy the file into the /etc/udev/rules.d/10-local.rules directory. If a file by
this name already exists, simply append the working file to it. For
example:

% sudo cp 10-local.rules /etc/udev/rules.d/ .
Or, if the file already exists:
% sudo cat 10-local.rules >>/etc/udev/rules.d/10-local.rules

5. Give permission to 10-local.rules as follows :

% sudo chmod 755 10-local.rules

6. Now reload the udev rules by

% sudo udevadm control –reload-rules

7. Plug in the usb cable.

Driver Setup for Lattice USB2A and HW-
USBN-2B (FTDI) USB Download Cable on Red 
Hat Linux Enterprise 6

Automated UDEV Method Configuration

1. Create an entry called “plugdev” in the /etc/group file, and then add
anyone logging into the system into that group. Make sure /usr/bin/id
shows you as a member of the plugdev group. Log out if required.

Example:

plugdev:x:501:username

2. Type the following command to execute the script:

% sudo <install_path>/data/vmdata/udevsetup_rh6

The script should terminate with a “Setup successful” output.

Manual UDEV Method Configuration

1. Create an entry called “plugdev” in the /etc/group file, and then add
anyone logging into the system into that group. Make sure /usr/bin/id

#Lattice
SUBSYSTEM=="usb",ACTION=="add",ATTRS{idVendor}=="1134",ATTRS{idProduct}=="8001",MODE==
"0660",GROUP=="username",SYMLINK+="lattice-%n"
#FTDI
SUBSYSTEM=="usb",ACTION=="add",ATTRS{idVendor}=="0403",ATTRS{idProduct}=="6010",MODE==
"0666",GROUP=="username",SYMLINK+="ftdi-%n"
SUBSYSTEM=="usb",ATTRS{idVendor}=="0403",ATTRS{idProduct}=="6010",RUN+="/bin/sh -c 
'basename %p > /sys/bus/usb/drivers/ftdi_sio/unbind'"

Note

Replace the username with your username in above rules.
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shows you as a member of the plugdev group. Log out if required. For 
example:

plugdev:x:501:username

2. Create a working file called 10-local.rules.

3. Add the following information to the 10-local.rules file:

4. Copy the file into the /etc/udev/rules.d/10-local.rules directory. If a file by
this name already exists, simply append the working file to it. For
example:

% sudo cp 10-local.rules /etc/udev/rules.d/.

Or, if the file already exists:

% sudo cat 10-local.rules >>/etc/udev/rules.d/10-local.rules

5. Make the new UDEV settings active, as follows:

% sudo /usr/bin/skill -HUP udevd

6. Plug in the USB cable.

Driver Setup for Lattice USB2A and HW-
USBN-2B (FTDI) USB Download Cable on Red 
Hat Linux Enterprise 5

Automated UDEV Method Configuration

1. Execute the script as follows:

% sudo <install_path>/data/vmdata/udevsetup

The script should terminate with a “Setup successful” output.

Manual UDEV Method Configuration

1. Create a working file called 10-local.rules.

#Lattice
BUS=="usb",ACTION=="add",SYSFS{idVendor}=="1134",SYSFS{idProduct}=="8001",MODE=="0660"
,GROUP=="plugdev",SYMLINK+="lattice-%n"
#FTDI
BUS=="usb",ACTION=="add",SYSFS{idVendor}=="0403",SYSFS{idProduct}=="6010",MODE=="0660"
,GROUP=="plugdev",SYMLINK+="ftdi-%n"
SUBSYSTEM=="usb",DRIVER=="ftdi_sio",ATTRS{idVendor}=="0403",SYSFS{idProduct}=="6010",A
TTR{bInterfaceNumber}=="00",RUN+="/bin/sh -c 'basename %p >/sys/bus/usb/drivers/
ftdi_sio/unbind'"

Note

Each BUS and SUBSYSTEM entry must be a single line, or split using the “\” line 
continuation character.
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2. Add the following information to the 10-local.rules file:

3. Copy the file into the /etc/udev/rules.d/10-local.rules directory. If a file by
this name already exists, simply append the working file to it. For
example:

% sudo cp 10-local.rules /etc/udev/rules.d/.

Or, if the file already exists:

% sudo cat 10-local.rules >>/etc/udev/rules.d/10-local.rules
% sudo chmod 755 /etc/udev/rules.d/10-local.rules

4. Create a working file called “lattice.perms”.

5. Add the following information to the lattice.perms file:

<lattice>=/dev/lattice*
<console>0660 <lattice>0660 root
<ftdi>=/dev/ftdi*
<console>0660 <ftdi>0660 root

6. Copy the file into /etc/security/console.perms.d directory as follows:

% sudo cp lattice.perms /etc/security/console.perms.d/.

Or, if the file already exists:

% sudo cat lattice.perms >>/etc/security/console.perms.d/
lattice.perms
% sudo chmod 755 /etc/security/console.perms.d/lattice.perms

7. Make the new UDEV settings active as follows:

% sudo /usr/bin/skill -HUP udevd

Driver Setup for Lattice USB2A Download Cable on 
Red Hat Linux Enterprise 4 and Older 

Automated Hot Plug Method Configuration:

The automated configuration script adds a line in the file /etc/hotplug/
usb.usermap and creates the file /etc/hotplug/usb/usbcable.

#Lattice
BUS=="usb",ACTION=="add",SYSFS{idVendor}=="1134",SYSFS{idProduct}=="8001",MODE=="0660"
,OWNER=="root",SYMLINK+="lattice-%n"
#FTDI
BUS=="usb",ACTION=="add",SYSFS{idVendor}=="0403",SYSFS{idProduct}=="6010",MODE=="0660"
,OWNER=="root",SYMLINK+="ftdi-%n"
BUS=="usb",DRIVER=="ftdi_sio",SYSFS{bInterfaceNumber}=="00",RUN+="/bin/sh -c 'basename 
`dirname %p` >/sys/bus/usb/drivers/ftdi_sio/unbind'"

Note

Each BUS and SUBSYSTEM entry must be a single line, or split using the “\” line 
continuation character.
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1. Navigate to the directory where you installed Gold2 . The default 
directory is <install_path>/gold2/1.0. Change directory to 
<install_path>/gold2/1.0/data/vmdata. Inside the directory is the file 
usbsetup.

2. Grant execute permissions to the usbsetup script by typing the following
command:

% sudo chmod 755 usbsetup

3. Make sure that you are in the directory where the usbsetup file is located.

4. Type the following command to execute the script:

% sudo ./usbsetup
The script should terminate with a “Setup successful” output.

Manual Hot Plug Method Configuration
Use the following manual configuration instructions. You can also use this 
method for a customized setup.

1. Edit the /etc/hotplug/usb.usermap file as follows:

% sudo vi /etc/hotplug/usb.usermap

2. Append the following line to the end of the file:

usbcable 0x0003 0x1134 0x8001 0x0000 0x0000 0x00 0x00 0x00
0x00 0x00 0x00 0x00000000

3. Use one of the following methods to create the script that will be executed
each time the USB device is inserted:

 Manually create the /etc/hotplug/usb/usbcable file.

In the following example, the device is owned by “root,” the group is
assigned to “usbusers,” and the device is readable and writable by
both “root” and “usbusers.”

#!/bin/bash if [ "${ACTION}" = "add" ] && [ -f
"${DEVICE}" ] then
chown root "${DEVICE}" chgrp usbusers "${DEVICE}" chmod
660 "${DEVICE}"
fi

When you create the usbcable file, pay attention to the spacing since
some statements are sensitive to the omission of spaces.

 Copy the Linux usbcam file and save it as usbcable.

On most versions of Linux, a usbcam script is available that changes
the device ownership to the user who inserts the cable and logs into
the console. The usbcam script is located in the same /etc/
hotplug/ directory.

If you prefer to use this script, copy the usbcam file and save it as
usbcable as follows:

% sudo cp /etc/hotplug/usbcam /etc/hotplug/usbcable

4. Grant the script execute permission as follows:
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% sudo chmod 755 /etc/hotplug/usbcable

HW-USBN-2B (FTDI) USB Download Cable 
Configuration on Red Hat Linux Enterprise 4 and 
Older
For Linux Enterprise 4 and older, only manual installation is available.

Manual Installation

1. Add the following line to /etc/fstab:

none /proc/bus/usb usbdevfs defaults,devmode=0666 0 0

There have been reports that you may need to use the following
command for some distributors:

none /proc/bus/usb usbdevfs defaults,mode=0666 0 0 (use
usbfs in 2.6 kernels)

2. Remount all in the fstab file

% mount -a

3. Plug in the cable.

4. Unload the ftdi_sio driver if it is attached to your device.

% sudo /sbin/rmmod ftdi_sio

5. Unload the usbserial driver if it is attached to your device.

% sudo /sbin/rmmod usbserial

If you have problems with these procedures, check with usbview (search on 
the internet for application or it can be sent to you by FTDI) to check the USB 
file system is mounted properly.

Note

The USB cable must be removed and reinserted whenever one user logs out and 
another user logs in. Otherwise, the system will still recognize the previous user as 
the owner of the cable, and an error message will be generated.
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Licensing Lattice Gold2  and Stand-Alone 
Power Estimator

The Lattice Gold2  development tool and stand-alone Power Estimator are 
licensed software. In order for you to launch the tools you have to configure 
a FLEXlm license. The license can be either node-locked to the local 
machine, or acquired from a license server accessible from a LAN 
connection. 

The default location of the license file is
<install_path>/gold2/1.0/license/license.dat. If this location is 
changed, you must set the LM_LICENSE_FILE environment variable to 
include the new path name.

License Management Versions
Table 3 lists the version numbers of the FLEXlm lmutil utility, the FLEXlm 
lmgrd utility, and the Lattice daemon used for license management for 64-bit 
systems.

Obtaining a License
To register and license your Gold2 software:

1. Obtain the host ID of your license server with the following command:% 

<install_path>/gold2/1.0/ispfpga/bin/lin64/lmutil lmhostid

Note

Gold2  permits the creation of configuration bitstreams for all of Lattice 
Semiconductor's FPGAs and CPLDs. However, a license is required for some 
devices.

Note

In order to change the LM_LICENSE_FILE variable, you may need to edit the .cshrc or 
.bashrc configuration file located in your home directory.

Table 3: License Management Utility Versions

Filename Version Description

lmutil 11.13.1.3 FLEXlm license server utility

lmgrd 11.13.1.3 FLEXlm end-user utility

lattice 11.4 The Lattice Semiconductor licensing daemon
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2. Go to the Licensing section of the Lattice Semiconductor Web site
(www.latticesemi.com/license) and follow the on-screen instructions.

Lattice Semiconductor will send your Gold2  license file (license.dat) to 
you by e-mail within one working day. After you receive the license file 
from Lattice Semiconductor, copy the license.dat file to the Gold2  
license directory as follows:

% <install_path>/gold2/1.0/license/license.dat

Editing the License File
You must edit a floating license file to specify the server name and the path to 
the Lattice daemon.

The following example shows part of a floating license file:

SERVER nodename 1234abcd 1710
DAEMON lattice daemon_path
FEATURE LSC_DIAMOND_A lattice 10.0 01-jan-9999 100 \
85B686493C86
VENDOR_STRING=LSC_DIAMOND_A

Edit the SERVER line by replacing the nodename with the host name and the 
port ID (1710). The port ID, 1710 in this example, must be assigned a TCP/IP 
port number that is not already in use on the server, so you might need to 
change it.

Edit the Lattice DAEMON line, replacing daemon_path with the path to 
Lattice Gold2 . For lmgrd V11, the path is:

% <install_path>/gold2/1.0/ispfpga/bin64/lin

When editing these lines, type them exactly as you received them. All entries 
are case-sensitive. 

Starting the License Manager
Type the following command on one line to start the license manager 
daemon:

% <install_path>/gold2/1.0/ispfpga/bin/lin64/lmgrd 
-l <install_path>/gold2/1.0/license/license.log 

Note

Lattice Semiconductor supports licensing for a single server or three redundant 
servers. If you are using three redundant servers, enter all three server host IDs 
on the License File/Registration Form.

Note

The encryption codes are in hexadecimal format (digits 0-9, and lower-case letters a-f 
or upper-case letters A-F). 

http://www.latticesemi.com/license
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-c <install_path>/gold2/1.0/license/license.dat

Redirecting output to a log file is helpful when you debug licensing problems. 
The -l switch tells the license manager to send its output to a log file 
(license.log), and -c tells it which license to serve. The log file contains 
information on the status of the server and the daemon and TCP port in use. It 
also shows which users have checked out the license and the checkout time.

Stopping the License Manager
If it is necessary to stop the FLEXlm license manager, follow this procedure:

1. Confirm that the daemon is running by typing the following command:

% ps -ef | grep lmgrd

2. If lmgrd.exe is running, type the following command on one line to stop the
daemon:

For 64-bit systems:

% <install_path>/gold2/1.0/ispfpga/bin/lin64/lmutil lmdown 
-c <install_path>/gold2/1.0/license/license.dat

The following prompt appears:

Shutting down FLEXlm on nodes: <hostname>
Are you sure? [y/n]:

3. Type Y and press Enter to shut down the license daemon.

Installing and Running the License 
Manager on a Remote Server
You can install and run the License Manager from a location other than the 
default directory.

To install the License Manager to a different location, copy the files lattice, 

lmgrd, and lmutil from the following directory:

% <install_path>/gold2/1.0/ispfpga/bin/lin/

to the desired location. For example:

% <remote_server_install_path>/my_machine/lattice_license/

Starting the License Manager from a Remote Server 
Type the following command on one line to start the license manager daemon:

% <remote_server_install_path>/lmgrd 
-l <install_path>/gold2/1.0/license/license.log 
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-c <install_path>/gold2/1.0/license/license.dat

Stopping the License Manager on a Remote Server 
If it is necessary to stop the FLEXlm license manager running on a remote 
server, follow this procedure:

1. Confirm that the daemon is running by typing the following command:

% ps -ef | grep lmgrd

2. If lmgrd.exe is running, type the following command on one line to stop the
daemon:

% <remote_server_install_path>/lmutil lmdown -c
<install_path>/gold2/1.0/license/license.dat

The following prompt appears:

Shutting down FLEXlm on nodes: <hostname>
Are you sure? [y/n]:

3. Type Y and press Enter to shut down the license daemon.

Setting Up a Floating License on Linux
The licensing steps just outlined can be performed on a centralized license 
server. Then each client points to the license file on that machine. 

To gain access to the licenses on the remote license server, you need to set 
the environment variable LM_LICENSE_FILE value to 
license_port_number@linux_host_name.

Troubleshooting a Floating License
The following procedures can be useful in troubleshooting common floating 
license issues.

Note

Lattice Gold2  software uses the following network communication ports (TCP/IP 
socket ports):

 Port 80 – This is the standard HTTP web access port.  Gold2  uses this port in
the following cases:

 When the Gold2  software has updates from the Lattice web site:

 IP or reference designs are downloaded from the Lattice web site:

 When message ID's are sent.

 Port 7788 – This is the port used by the Gold2  software to check the floating
license between the software and license server.  This port is configurable by
changing the license files.
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Check the Network

Use the ping command to check network status. For example, type:

% ping <license_server>

If the license server is running, you can expect a return as follows: 

64 bytes from <license_server> <IP_address>

To end, type CTRL+C.

Check License File with lmutil

Use the lmutil tool to troubleshoot the status of your license file. The lmutil tool 

is located in the following location:

<install_path>/gold2/1.0/ispfpga/bin/lin64

The lmstat command determines the features of your license file.

 The -a argument displays all information.

 The -c argument uses the specified license files.

The following is an example of using the lmutil lmstat command to check the 
license file status:

% ./lmutil lmstat -a -c <license_port>@<license_server>

The license status is returned, including feature lines, number of licenses 
issued, and licenses in use.

Running the Lattice Gold2 GUI
The Lattice Gold2 software has a graphical user interface (GUI). When you 
run the Gold2 1.0 executable file, the software automatically performs the 
environment setup.

To start the Lattice Gold2  GUI:

1. Set up the license as follows:

If your license file (license.dat) is not under <install_path>/gold2/1.0/
license, you must set the LM_LICENSE_FILE variable to the location of
your license file. For example:

For CSH users:

% setenv LM_LICENSE_FILE (/<license_directory>/license.dat
$LM_LICENSE_FILE)

For BASH users:
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% export LM_LICENSE_FILE=$LM_LICENSE_FILE:/
<license_directory>/license.dat

2. Run the Gold2  executable file in the command line as follows:

%<install_path>/gold2/1.0/bin/lin64/gold &

With the diamond script, you can also run the following tools in stand-

alone mode.

To invoke stand-alone Power Calculator, run:

% gold -pwc

To invoke stand-alone Reveal Analyzer, run:

% gold -rva

To invoke stand-alone IPexpress, run:

% gold -ipx

To invoke stand-alone Epic, run:

% gold -epic

Refer to the online Help for more information about the Gold2  GUI.

Using the Examples Directory
In order to use the design examples directory, you must copy the files from the 
server to your local system and change the write permissions. Copy the files 
from the server examples directory (<install_path>/gold2/1.0/examples) to 
the equivalent path and directory on your local system.

Finding the Installation History
The Gold2  software records a log of your installation history. You can find 
the history in the Gold2  main window.

To view the installation history:

1. Open the Gold2  GUI.

2. Choose Help > About Lattice Gold2.

Running Lattice Gold2 from the Command Line
There are two ways to run from the command line: through Gold2’s Tcl 
Console or by running executable files directly.
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Running Stand-Alone Tcl Console
The Lattice Gold2 development environment includes Tcl Console, which 
allows you to run scripts for automating common tasks. Tcl Console is also 
available outside of the user interface in order to run custom scripts. To launch 
the stand-alone Tcl Console, enter the following on a command line:

% <install_path>/gold2/1.0/bin/lin64/goldc

These commands configure the environment allowing all of the underlying 
design tools to be run. Refer to the online Help for more information about the 
command line.

Running Using CSH or Bash 
Interpreters
Before running any other commands, you need to run the following command:

% cd <install_path>/gold2/1.0/bin/lin64 

% source setupenv

BASH users must run the following commands:

% export bindir=<install_path>/gold2/1.0/bin/lin64 % 

source $bindir/gold_env

After that, you can run the executable files directly. For example, you can 
invoke the Gold2 GUI by:

% pnmain &

Or, you can run Power Calculator by running:

% pwcmain &

Running Synplify Pro for Lattice
To run Synplify Pro for Lattice, do the following:

1. Open the Gold2 GUI.

2. Open any project to enable the commands on the Tools menu.

3. Choose Tools > Synplify Pro for Lattice.

Running Stand-Alone Reveal Analyzer
After the installation, you can invoke the stand-alone Reveal Analyzer in the 

command line:

% <install_path>/reveal/gold2/1.0/bin/lin64/revealrva &

(NOT supported in Lattice Gold2)
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Running Stand-Alone Programmer
After the installation, you can invoke the stand-alone Programmer in the 

command line:

% <install_path>/programmer/gold2/1.0/bin/lin64/programmer &

Running Stand-Alone Deployment Tool
After the installation, you can invoke the stand-alone Deployment Tool in the 

command line:

% <install_path>/programmer/gold2/1.0/bin/lin64/deployment &

Running Stand-Alone Debugger
After the installation, you can invoke the stand-alone Debugger in the 
command line:

Running Download Debugger on 64-bit systems:

% <install_path>/programmer/gold2/1.0/bin/lin64/debugger &

Running Stand-Alone Programming File Utility
After the installation, you can invoke the stand-alone Programming File Utility 

in the command line:

% <install_path>/programmer/gold2/1.0/bin/lin64/fileutility &

Running Stand-Alone Model 300 Programmer
After the installation, you can invoke the stand-alone Model 300 Programmer 

in the command line:

% <install_path>/programmer/gold2/1.0/bin/lin64/model300 &

Running Stand-Alone Power Estimator
After the installation, you can invoke the stand-alone Power Estimator in the 
command line:

Note

The stand-alone Power Estimator requires a license. See “Licensing Lattice Gold2 
and Stand-Alone Power Estimator” on page 25.
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% set ROOT="<install_path>/powerestimator/gold2/1.0"
% set platform=lin64
% setenv LD_LIBRARY_PATH ${ROOT}/ispfpga/bin/
${platform}:${ROOT}/bin/${platform}
% set path=(${ROOT}/ispfpga/bin/${platform} ${ROOT}/bin/
${platform} $path)
% ${ROOT}/bin/${platform}/pwcwrap est &

Running Multiple Versions of Lattice Software
You can run multiple versions of ispLEVER and Lattice Gold2 at the same 
time from either the command line or the graphical user interface. You can 
run current and previous versions.

Updating Lattice Gold2
After you have registered and licensed your installation, check the Lattice 
Semiconductor Web site for new software updates, device support, and 
enhancements. Make sure that you have the latest software by checking for 
updates regularly.

Running the UPDATE Tool
To run the UPDATE tool:

 Run the update executable file in the command line:

% update

The UPDATE window appears, as shown below.

(NOT supported in Lattice Gold2)
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Changing the Network Setting
To enable online checking for software updates, you must indicate how your 
computer accesses the Internet.

To change the Internet connection settings:

1. In the UPDATE window, choose Settings > Update Settings.

2. In the Update Settings dialog box, select the Network Setting tab.

3. In the Network Setting tab, do either of the following:

 If you must go through a proxy server before connecting to the
Internet, select Use a Proxy Server (it is selected by default). The
proxy server prevents outsiders from breaking into your organization’s
private network. Ask your system administrator for the URL address
and port assignment.

 If you use direct Internet access, clear the Use a Proxy Server option.

4. Click OK.

Downloading and Installing Software 
Updates
When you use the automatic checking feature, the Gold2 software notifies 

you whenever an update version becomes available.

You can also manually check for software updates.

To manually check for and download a Gold2 update version:

1. In the UPDATE window, click Update.

The software goes online to check for updates, and lists the available

Gold2 update versions (if any) in the Available update versions box.

2. Select the update version that you want to download, and click
Download.
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The software starts downloading the installer of the update version to your 
computer. You may install it later.

To install a downloaded Gold2 update version:

1. Close all Gold2 tools.

2. Uncompress the downloaded installer.

3. Go to the location where you put the uncompressed installer.

4. From the command line, execute the RPM installation file.

Note

You can also use the Help > Check for Updates command in the Gold2 window to 
check for and download software update.

Note

You need the root privilege to install an RPM package.
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Chapter 2ls

Installing LatticeMico 
Development Tools

This document explains how to install LatticeMico Development Tools on the 
Linux operating system.

System and Software Requirements
Your system must meet the following minimum system and software
requirements to run LatticeMico Development Tools on Linux.

System Requirements
 Intel Pentium or Pentium-compatible PC with USB port

 64-bit Red Hat Enterprise Linux version 4, 5, 6, 7 operating system

 2 GB memory recommended for FPGAs

 Approximately 436 megabytes of free disk space

 1024 x 768 graphics display

Software Requirements
 Perl version 5.8.0 or later. The following Perl modules are required:

 XML::DOM

 XML::Parser

 XML::RegExp

 Getop::Std

IMPORTANT: 
LatticeMico Development Tools are NOT supported in this 
version of Lattice Gold2 release.
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 Scalar::Util

 FindBin::Bin

These modules are normally found in the native version of Perl that 
comes with Red Hat Linux.

 PDF browser, such as Adobe Acrobat

 Mozilla or Netscape browser (optional)

Additional Notes for Linux
You may need the following information to run LatticeMico on Linux:

 If you want to configure your system to use an external browser instead of
the Eclipse help browser, you can change this in the LatticeMico main
window by choosing the Window > Preferences command.

 Eclipse requires shared libraries from the Mozilla (also known as
Seamonkey) Web browser. The Eclipse software expects to find a set of
IA32 shared libraries. It may be necessary for you to manually configure
the MOZILLA_FIVE_HOME environment variable to point to a valid
Mozilla browser library installation.

 If you cannot access the PDF files referenced in the LatticeMico online
Help, you can configure LatticeMico to use an external browser by
following these steps:

a. In the LatticeMico software, choose Window > Preferences.

b. Click on Help.

c. Select Use external browser.

d. Click on Web Browser.

e. Select Use external Web browser.

f. Select Firefox or Netscape.

g. Click OK.

Installing LatticeMico Within Gold2 Software
To take advantage of the full features and functionality of the LatticeMico 
Development Tools, Lattice Semiconductor recommends that you install the 
2.0 version of Gold2 before installing the LatticeMico Development Tools.

Users designing with Platform Manager 2 devices must install 
LatticeMico System with Gold2 in order to make the Gold2 
Platform Designer software functional.
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The LatticeMico software is available for download from the Lattice 
Semiconductor Web site. For more information on how to download the 
LatticeMico software, go to http://www.latticesemi.com/latticediamond and 
click the Downloads tab. Some documents and downloads are not visible to 
anonymous visitors. To view all items, please log in to your Lattice account.

This section describes how to install the LatticeMico Development 
Tools on top of the Gold2 software. These procedures assume that you 
have already installed Gold2 1.0.

To install LatticeMico Development Tools:

1. Install Lattice Gold2 1.0 first, for example, in <install_path>/gold2.

2. Verify the integrity of the RPM file.

% cd <directory_with_RPM>
% rpm -K lms_1_1_for_diamond3_11

3. Execute the RPM installation file as follows:

To install to the default location (/usr/local/gold2), use:

% sudo rpm -Uvh <path_to_package>/

lms_1_1_for_diamond3_11.rpm

To override the default location use:

% sudo rpm -Uvh --prefix=<install_path> 
<path_to_package>/gold2/1.0/micosystem

4. After the installation is completed, verify that the /micosystem directory is 
created in the <install_path>/gold2/1.0 directory, for example, /usr/local/
gold2/1.0/micosystem.

5. You can then run LatticeMico System as follows:

% <install_path>/gold2/1.0/micosystem/

LatticeMicoLauncher &

Installing LatticeMico as a Stand-Alone Tool
If you do not have the current version of Gold2 installed, you can still install 
the LatticeMico Development Tools, but their functionality will be limited. 
Mico System Builder (MSB) will not be fully functional. You can create 
platforms, but the platform generator will not be fully functional because of 
missing Gold2 executables and functions. The design-rule checker will also 
not be fully functional. However, the graphical user interfaces of the C/C++ 
Software Project Environment (C/C++ SPE) and the debug environment will 
be fully functional.

Note

You need the root privilege to install an RPM package.

Note

You need the root privilege to install an RPM package.

http://www.latticesemi.com/latticediamond
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To install LatticeMico Development Tools:

1. Verify the integrity of the RPM file.

% cd <directory_with_RPM>

2. Execute the RPM installation file as follows:

To install to the default location, use:

% sudo rpm -Uvh <path_to_package>/
lms_1_1_for_diamond3_11.rpm

To override the default location use:

% sudo rpm -Uvh --prefix=<install_path> 

<path_to_package>/gold2/1.0/micosystem

3. After the installation is completed, verify that the /micosystem directory is 
created in the <install_path>/latticemicosystem/gold2/1.0 directory, for 
example, /usr/local/latticemicosystem/gold2/1.0/micosystem.

LatticeMico System Library Dependencies
LatticeMico System for Linux depends on a set of system libraries 
that are different from the Gold2 base release package.

The following packages are the packages on which 
lms_1_1_for_diamond3_11.rpm are dependent. Indirect dependencies are 
listed with indented levels.

 glibc

 nss-softokn-freebl

 libjpeg

 glib2

 libselinux

 gamin

 libusb

 freetype

 fontconfig

 expat

 libX11

 libxcb

 libXau

 libICE

 libSM

 libuuid

 libXt
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 libXext

 libXrender

 libXi

 libXft

 libXtst

 alsa-lib

 atk

 nss

 nss-util

 nspr-devel

 nspr

 nss-softokn

 sqlite

 readline

 ncurses-libs

 gmp

 pango

 cairo

 libthai

 libpng

 pixman

 libXcomposite

 libXfixes

 libXdamage

 libXinerama

 libXrandr

 compat-expat1

 compat-libstdc++-33

 cups-libs

 avahi

 audit-libs

 avahi-libs

 dbus-libs

 libcap

 libattr

 libdaemon
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 libtiff

 gnutls

 keyutils-libs

 krb5-libs

 libgcrypt

 libgpg-error

 libtasn1

 gtk2

 jasper-libs

 perl-XML-DOM

 perl-XML-RegExp

Installing System Library Packages 
Manually on Red Hat 6 64-bit Operating 
Systems

The following sequence shows how the system libraries must be installed 
before the diamond_3_11-lm LMS package can be installed. The example 
assumes the Red Hat Enterprises 6 64-bit installation DVD is mounted in the 
following path:

/media/RHEL_6.2\ x86_64\ Disc

There are 64 packages that must be installed manually before installing the 
LatticeMico package. Some of the commands below install more than one 
package. These packages have cyclic dependencies.

# cd /media/RHEL_6.2\ x86_64\ Disc/Packages/
# rpm -i glibc-2.12-1.47.el6.i686.rpm \

     nss-softokn-freebl-3.12.9-11.el6.i686.rpm
# rpm -i libjpeg-6b-46.el6.i686.rpm
# rpm -i zlib-1.2.3-27.el6.i686.rpm
# rpm -i glib2-2.22.5-6.el6.i686.rpm \

     libselinux-2.1.94-5.2.el6.i686.rpm \
     gamin-0.1.10-9.el6.i686.rpm 

# rpm -i libgcc-4.4.6-3.el6.i686.rpm 
# rpm -i libstdc++-4.4.6-3.el6.i686.rpm
# rpm -i libusb-0.1.12-23.el6.i686.rpm
# rpm -i freetype-2.3.11-6.el6_1.7.i686.rpm
# rpm -I expat-2.1.1-9.1.el6.i686.rpm 
# rpm -i fontconfig-2.8.0-3.el6.i686.rpm
# rpm -i libSM-1.1.0-7.1.el6.i686.rpm \

     libuuid-2.17.2-12.4.el6.i686.rpm
# rpm -i libXt-1.0.7-1.el6.i686.rpm
# rpm -i libXext-1.1-3.el6.i686.rpm
# rpm -i libXrender-0.9.5-1.el6.i686.rpm
# rpm -i libXi-1.3-3.el6.i686.rpm
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# rpm -i libXft-2.1.13-4.1.el6.i686.rpm
# rpm -i libXtst-1.0.99.2-3.el6.i686.rpm 
# rpm -i alsa-lib-1.0.22-3.el6.i686.rpm
# rpm -i atk-1.28.0-2.el6.i686.rpm 
# rpm -i nspr-4.8.8-3.el6.i686.rpm
# rpm -i nspr-devel-4.8.8-3.el6.i686.rpm
# rpm -i nss-util-3.12.10-2.el6.i686.rpm
# rpm -i ncurses-libs-5.7-3.20090208.el6.i686.rpm
# rpm -i readline-6.0-3.el6.i686.rpm
# rpm -i sqlite-3.6.20-1.el6.i686.rpm
# rpm -i nss-softokn-3.12.9-11.el6.i686.rpm
# rpm -i nss-3.12.10-16.el6.i686.rpm
# rpm -i gmp-4.3.1-7.el6.i686.rpm
# rpm -i pixman-0.18.4-1.el6_0.1.i686.rpm
# rpm -i libpng-1.2.46-1.el6_1.i686.rpm
# rpm -i cairo-1.8.8-3.1.el6.i686.rpm
# rpm -i libthai-0.1.12-3.el6.i686.rpm
# rpm -i pango-1.28.1-3.el6_0.5.i686.rpm
# rpm -i libXfixes-4.0.4-1.el6.i686.rpm 
# rpm -i libXcomposite-0.4.1-2.el6.i686.rpm 
# rpm -i libXdamage-1.1.2-1.el6.i686.rpm 
# rpm -i libXinerama-1.1-1.el6.i686.rpm 
# rpm -i libXrandr-1.3.0-4.el6.i686.rpm 
# rpm -i audit-libs-2.1.3-3.el6.i686.rpm
# rpm -i dbus-libs-1.2.24-5.el6_1.i686.rpm 
# rpm -i avahi-libs-0.6.25-11.el6.i686.rpm 
# rpm -i libattr-2.4.44-7.el6.i686.rpm 
# rpm -i libcap-2.16-5.5.el6.i686.rpm 
# rpm -i libdaemon-0.14-1.el6.i686.rpm 
# rpm -i avahi-0.6.25-11.el6.i686.rpm 
# rpm -i libtiff-3.10.4-1.el6_0.3.i686.rpm 
# rpm -i compat-expat1-1.95.8-8.el6.i686.rpm
# rpm -i compat-libstdc++-33-3.2.3-69.el6.i686.rpm
# rpm -i gnutls-2.8.5-4.el6.i686.rpm
# rpm -i keyutils-libs-1.4-3.el6.i686.rpm
# rpm -i krb5-libs-1.9-22.el6.i686.rpm
# rpm -i libgcrypt-1.4.5-9.el6.i686.rpm
# rpm -i libgpg-error-1.7-4.el6.i686.rpm
# rpm -i libtasn1-2.3-3.el6.i686.rpm
# rpm -i cups-libs-1.4.2-44.el6.i686.rpm
# rpm -i jasper-libs-1.900.1-15.el6.i686.rpm
# rpm -i gtk2-2.18.9-6.el6.i686.rpm
# rpm -i perl-XML-RegExp-0.03-7.el6.noarch.rpm
# rpm -i perl-XML-DOM-1.44-7.el6.noarch.rpm
# rpm -i lms_1_1_for_diamond3_11.rpm

After you install the above system library packages, the following LatticeMico 
package can be installed.

# rpm -i lms_1_1_for_diamond3_11.rpm

Note that this example is based on Red Hat Enterprises 6 64 Update 2 
release. If you have a different Red Hat Enterprises 6 64 update release, the 
version number may be different on your installation DVD image.
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Using an Automatic Package Installer to 
Install LatticeMico RPM Package

If you have a YUM repository setup as described in “Using an Automatic 
Package Installer for RPM Systems” on page 13 you only need to run the 
following command to install diamond_3_11-lm without going through the 
manual RPM installation process described in “Installing System Library 
Packages Manually on Red Hat 6 64-bit Operating Systems” on page 41.

% yum install lms_1_1_for_diamond3_11.rpm

Running LatticeMico System
After LatticeMico System is installed, enter the following command to run the 
software:

% <install_path>/latticemicosystem/gold2/1.0/
LatticeMicoLauncher &
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